# Table of Contents

INTRODUCTION ..................................................................................................................................................... 1

   How to Use This Guide........................................................................................................................................... 1
   Software Editions Supported ................................................................................................................................. 2

HOW INTEGRATION WORKS .................................................................................................................................. 3

   Integration Rules........................................................................................................................................................ 4
   Sync Settings .............................................................................................................................................................. 5
      General Settings.................................................................................................................................................. 6
      Send Settings ..................................................................................................................................................... 8
      Get Settings ..................................................................................................................................................... 8
      Sage 50 Accounts ................................................................................................................................................. 9
      Payroll Settings ................................................................................................................................................ 13

INITIAL INTEGRATION .......................................................................................................................................... 14

   Security Permissions ........................................................................................................................................... 14
   Scenario 1: Existing BillQuick-New Peachtree User .............................................................................................. 15
   Scenario 2: New BillQuick-Existing Peachtree User .............................................................................................. 21
   Scenario 3: New BillQuick-New Peachtree User ................................................................................................... 26
   Scenario 4: Existing BillQuick-Existing Peachtree User .......................................................................................... 38

QUICK CHECK ....................................................................................................................................................... 43

DAY-TO-DAY INTEGRATION SETTINGS ................................................................................................................. 51

   Master Information ............................................................................................................................................. 51
   Time Records .................................................................................................................................................... 52
   Expense Records ............................................................................................................................................... 53
   Invoice Records .................................................................................................................................................. 54
   Late Fee Invoices ................................................................................................................................................ 55
   Payments ........................................................................................................................................................... 55

BEST PRACTICES .................................................................................................................................................. 56
Introduction

Data integration between BillQuick® (by BQE Software, Inc.) and Peachtree Accounting® (now Sage 50 – US Edition) can make your time billing, accounting and financial management tasks easier. Full-featured, BillQuick helps you manage your company, whether your time, expense, billing, project management and reporting needs are simple or you demand complex billing, reporting and management capabilities. Sage 50 Accounting is a business accounting software that provides solutions such as general accounting, limited time and billing, accounts receivable, accounts payable, inventory, online banking, job costing, reporting and payroll services. Integrated, BillQuick and Sage 50 deliver a virtual application that ensures data accuracy, eliminates time-consuming duplicate manual entry, enhances flexibility, and increases control over your bottom line.

The goal of the BillQuick↔Peachtree Integration Guide is to help users effectively integrate data between BillQuick and Sage 50 Accounting. BillQuick controls integration, enabling you to choose General Ledger accounts, what data flows between the applications, and more.

How to Use This Guide

Integration means data from one application transfers to another. This sharing offers many benefits. You control what data transfers to and from BillQuick using synchronization settings. Your preferences tell BillQuick exactly how you want it to interact with Sage 50. BillQuick automatically creates smart connection using your settings and built-in intelligence.

We encourage you to review the How Integration Works section. Written for the non-technical user, it explains the integration rules built into BillQuick. Understanding what type of data may be shared and the rules applied during synchronization, will help you visualize what is happening behind the scenes.

In the Initial Integration section, you can choose the scenario which best fits your company. Instructions guide you through initial integration process according to your situation, whether new or existing BillQuick/Sage 50 user.

After integration, data is to be checked to make sure everything is synchronized accurately. The Quick Check section provides specific guidance on this aspect. The section on Day-to-Day Integration Settings provides suggestions for fine-tuning synchronization settings for normal, day-to-day processing.
Software Editions Supported

BillQuick Basic (Microsoft Access), Pro (Microsoft Access and SQL Express database) and Enterprise (Microsoft Access, SQL Express and Microsoft SQL database) editions (2005 or later) integrate with the following Peachtree/Sage 50 editions:

- Peachtree Accounting/Sage 50 Accounting®-US Edition
- Peachtree/Sage 50® Complete Accounting and Peachtree/Sage 50® Premium Accounting (2005 or later)
- Peachtree Premium Accounting® (2005 or later)
- Peachtree Premium Accounting for Construction/ Sage 50 Construction Accounting, Peachtree Premium Accounting for Distribution/ Sage 50 Distribution Accounting, Peachtree Premium Accounting for Manufacturing/ Sage 50 Manufacturing Accounting Peachtree Premium Accounting for Non-Profit/ Sage 50 Non-Profit Accounting (2006 or later)
How Integration Works

Even if you are not a technical person, it is helpful to understand the basics of BillQuick↔Peachtree Accounting integration. This can help you visualize what is happening behind the scenes as BillQuick manages transfer of information to and from Sage 50.

You can send BillQuick activities, expense codes, employees, vendors, clients, projects, time entries, invoices and payments to Sage 50. You can get activity and expense/charge items, employees, vendors, customers, jobs, expense and time entries, invoices and payments from Sage 50 into BillQuick. You have to send or get the data in the order of the menu. E.g., send Clients prior to sending the Projects. Each record common to BillQuick and Sage 50 share a unique Link ID that identifies them as related. This does not mean data in both records is exactly the same, only that they share common data. BillQuick Project records contain data and options that Sage 50 Job records do not and vice versa. What is important for integration is that the two applications share key data.

Before integrating data, back up your data in Sage 50 Accounting and BillQuick.

The table below shows the directions in which data can potentially flow between BillQuick and Sage 50. Whether it flows in one direction or the other depends on your choices on the BillQuick↔Peachtree Sync Settings screen.

<table>
<thead>
<tr>
<th>BillQuick Table Name</th>
<th>Dataflow</th>
<th>Peachtree Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Codes</td>
<td>➡️</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Activity)</td>
</tr>
<tr>
<td>Expense Codes</td>
<td>➡️</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Charge)</td>
</tr>
<tr>
<td>Employee</td>
<td>➡️</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendor</td>
<td>➡️</td>
<td>Vendor</td>
</tr>
<tr>
<td>Client</td>
<td>➡️</td>
<td>Customer</td>
</tr>
<tr>
<td>Project</td>
<td>➡️</td>
<td>Job</td>
</tr>
<tr>
<td>Time Entry</td>
<td>➡️</td>
<td>Time Ticket</td>
</tr>
<tr>
<td>Expense Log</td>
<td>➡️</td>
<td>Expense Ticket</td>
</tr>
<tr>
<td>Invoice</td>
<td>➡️</td>
<td>Sales/Invoicing</td>
</tr>
<tr>
<td>Payments</td>
<td>➡️</td>
<td>Receipts</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>➡️</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>➡️</td>
<td>Purchase Orders</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>➡️</td>
<td>Vendor Bills</td>
</tr>
</tbody>
</table>

To review detailed, field-by-field mapping of records between Sage 50 Accounting and BillQuick, see BillQuick Help, BillQuick↔Peachtree Integration, Table & Field Mapping.
As you can see above, BillQuick’s integration with Sage 50 is very comprehensive. Not only are invoices sent to Sage 50 to post revenue and receivables, the virtual database for the two applications includes clients, projects/jobs, employees, vendors, activity codes, etc.

*Bottom Line*: The major benefit is that you do not have to re-enter BillQuick data into Sage 50. BillQuick manages the process, using your synchronization settings.

### Integration Rules

To ensure accuracy and completeness of data transfer, BillQuick↔Peachtree integration follows a set of rules. These are:

1. **Start Date**: Sage 50 accepts the transfer of time, expense, invoice and payment records only if their dates are after the start date of the Sage 50 Company. Thus, when you are an existing BillQuick user integrating with Sage 50 for the first time, or you are new to both BillQuick and Sage 50 and manually entering invoices, payments, and/or time and expenses from a prior fiscal year, be sure to check the start date of the Sage 50 Company.

2. **Synchronization Order**: When you send or get data on-demand from BillQuick or Sage 50 (via Send, Get or Sync menu), follow the order of the sub-menus for speedier data transfer. For example, you should synchronize Clients before Projects and Invoices before Payments.

3. **PTLinkID**: BillQuick automatically creates an internal PTLinkID and adds it to the database. Used for internal processing, the special ID ensures accurate and complete transfer of data.

4. **Placeholder Data**: Because Sage 50 does not require the same data fields as BillQuick and it may not track the same data as BillQuick (does not have the same fields), BillQuick inserts ‘FromPeachtree’ (for example) as a placeholder value when it encounters these situations. As part of the data checking procedure, you would change FromPeachtree to whatever value you desire for the field. For example, if the First and Last Name fields on Sage 50’s Vendor screen are blank, BillQuick inserts FromPeachtree into its First and Last Name fields during synchronization.

5. **Rates**: When transferring employee data from Sage 50, BillQuick inserts 0$ Bill Rate and Pay Rate. This is because Sage 50 supports only hourly billing with optional Bill Rate and no Cost Rate.

6. **Client Contacts**: Client contacts in BillQuick transfer to Sage 50 automatically when you synchronize clients.

7. **Project**: BillQuick handles the integration of project phases with Sage 50.

8. **Time Entry**:
   - After transferring a time record from BillQuick to Sage 50, it can only be transferred again as a new entry or record.
   - Negative time entries cannot be transferred from BillQuick to Sage 50.

9. **Purchase Orders and Vendor Bills**: Purchase orders and vendor bills are integrated between BillQuick and Sage 50. The received items information is also transferred against the appropriate purchase order, adjusting the vendor bill accordingly.

10. **Sage 50 Invoices**: When transferring invoices from Sage 50 to BillQuick, several scenarios can arise.
How Integration Works

- **Client Invoice but No Job Record:** When BillQuick encounters an invoice from Sage 50 that is associated with a client rather than a job/project, it automatically creates a project record and uses the Client ID to create the Project ID. This is done because BillQuick requires projects, and invoices are associated with projects (scopes or types of work) done for clients.

- **Invoice for One Job, different Client:** When BillQuick encounters an invoice from Sage 50 that contains items for a single project with a client other than the invoice client; it associates the invoice with the specific client of the project.

- **Invoices for Multiple Jobs, Same Client:** When BillQuick encounters an invoice from Sage 50 with items for different jobs but the same client, it creates a 'joint invoice'. In other words, the invoice items for each job are associated with the corresponding project in BillQuick. Together, they are reported in BillQuick as a Joint Invoice.

- **Invoices for Multiple Jobs, Different Clients:** When BillQuick encounters an invoice from Sage 50 with items for different jobs and those jobs involve more than one client, BillQuick will not transfer the invoice. You must revise the invoice in Sage 50 so it only reflects items for jobs associated with a single client, and then synchronize with BillQuick again.

11. **BillQuick Invoice:**
   - When BillQuick sends an invoice with taxes to Sage 50, there are two items (Service Amount and Service Tax Amount) appearing as a single line item. Hence, different accounts cannot be specified for them.
   - Joint Invoices are integrated between BillQuick and Sage 50.

12. **Payment:** Like invoices, when transferring payments to/from BillQuick, several scenarios can arise.
   - **Payment to Client Invoice, No Job:** When BillQuick encounters a payment from Sage 50 for a client invoice rather than a job/project invoice, it automatically creates a project record (if it does not exist) and uses the Client ID to create the Project ID. This is done because BillQuick requires projects, and invoices are associated with projects (scopes or types of work) done for clients.
   - **From Sage 50 Payments, No Invoice in BillQuick:** When BillQuick encounters a payment from Sage 50 for which the associated invoice does not exist in BillQuick, it will transfer the payment into BillQuick. The payment is 'on-account' for the client and can be used to pay invoices and/or reduce the net bill amount of future invoices.
   - **No Invoice:** A payment entered in BillQuick/Sage 50 transfers to Sage 50/BillQuick even if the associated invoice does not exist in the other application.

Sync Settings

In BillQuick, you can specify data transfer rules and settings in the BillQuick-Peachtree Sync Settings screen. These settings apply company-wide and are used as defaults when you choose to synchronize data between BillQuick and Sage 50.

Using the BillQuick-Peachtree Sync Settings screen, you can specify the following:
How Integration Works

- General Settings
- Send Settings
- Get Settings
- Accounts
- Payroll Settings

General Settings

The General tab allows you to set rules for data transfer between BillQuick and Sage 50 database. You can specify database options here for the data sync. *For description of each field on this tab, see the BillQuick Help.*

![BillQuick - Peachtree Sync Settings](image)

**Cost Code Settings:**

By default, BillQuick sends activities/expenses to Sage 50 Inventory Item screen with Item Class field for Activity as Activity Item and for Expense as Charge Item. On getting activities/expenses from Sage 50 to BillQuick, the inventory items with Item Class as Activity Item are brought in as Activity and inventory items with Item Class as Charge Item are brought in as Expense.

However, if the rule ‘Map Cost Codes to BillQuick Activity/Expense Codes’ is checked, then on sending activities/expenses to Sage 50, activities as well as expenses are sent as Cost Codes with cost type as
Labor for activities and Other for expenses. On getting activities/expenses from Sage 50 to BillQuick, Cost Codes with cost type as Labor are brought in as Activity and others are brought in as Expense.

With Map Cost Codes to BillQuick Activity/Expense Codes rule checked, details at project level get changed.

In Sage 50 a project can have a Phase and a phase can have a Cost Code so the possible combinations for a Project field are:

- Project
- Project and Phase
- Project, Phase and Cost Code

**Case I:** When Job field is set to Project in Sage 50:
On getting records of time and expense; these will be brought to BillQuick Time and Expense Entry screens respectively. Project will be set as normally done and Labor will be brought as Activity in BillQuick.

**Case II:** When Job field is set to Project and Phase in Sage 50:

On getting records of time and expense; these will be brought to BillQuick Time and Expense Entry screens respectively. Project will be created on the fly with Project ID as Project, Phase which will become the project ID of time and expense entry and Labor will be brought as Activity in BillQuick.

**Case III:** When Job field is set to Project, Phase and Cost Code in Sage 50:

On getting records of time and expense; these will be brought to BillQuick Time and Expense Entry screens respectively. Project will be created on the fly with Project ID as Project, Phase which will become the project ID of time and expense entry and Cost Code will be brought as Activity in BillQuick.

The Activity field in all the above scenarios is not filled by the activity value of the time entry but by the Cost Code of the time entry and if the cost code is not specified for the time entry then Activity field is set as Labor (a default activity).

Similar is the case with Expense but here the default expense is Expense, if the Cost Code is not set.

On sending time entries/expense entries to Sage 50, the Activity/Expense is appended to the Project (which becomes a combination as Project, Phase, and Cost Code for Sage 50) before sending the time/expense entries. If the Project, Phase, Cost Code combination is not set in Sage 50, the time/expense entry will not be sent.

This happens, for example, with our above time entry where in Labor was brought in as Activity. If we send other time entry and use Labor as an activity in BillQuick and send the time entry it will fail because the labor is missing in Sage 50 Cost Code, so there will be no combination like {Project}:{Phase}:Labor.

On sending other data like invoices and payments, only Project and Phase is important to set and **not** the Cost Code.
Send Settings

Send Settings allow you to set rules for data transfer from BillQuick to Sage 50 database. You can also restrict the data sent from BillQuick to Sage 50 and specify filters.

The Send options change depending upon the module selected from the list on the left of the screen.

You can specify the various settings per module for sending data to Sage 50. For description of each field on this tab, see the BillQuick Help.

Get Settings

Get settings allow you to set rules for data transfer from Sage 50 to BillQuick database. You can also restrict the data received from Sage 50 into BillQuick and specify filters.

The Get options change depending upon the module selected on the left of the screen.
You can specify various settings per module for getting data from Sage 50. For description of each field on this tab, see the BillQuick Help.

**Sage 50 Accounts**

A general ledger contains financial transactions and balances in various accounts for the specified fiscal year or time period. It represents a complete collection of accounts (chart of accounts) of a company, transactions associated with these accounts, and account balances for a specified period of time.

For companies that integrate BillQuick with Sage 50, they need to specify default General Ledger accounts for the services, expenses, invoice and other items in BillQuick (prior to the sync). Normally, the transactions debit or credit these accounts. While sending BillQuick data to Sage 50, you must specify default accounts for BillQuick items such as activities, expenses, invoices, payments, etc. This is required so that transactions related to these items are posted to the correct accounts in Sage 50.

The G/L account that you select depends on whether your company follows a Cash Basis or Accrual Basis of accounting. For cash basis, the Income Account is where payments from BillQuick are posted. The Sales Account receives invoiced activities or services; and the Inventory Account receives invoiced expenses. BillQuick posts costs (time, expenses) associated with an invoice to the Cost of Sales Account. For accrual basis, the same accounts are used except that the Income Account is not needed. Income
account contains revenue items (say, from the sale of products and services to the customers). Similarly, expense account contains expenditure items that are incurred on products and services for the specified fiscal year. For your business, you may need to create specific income and expense accounts based upon the products and services you offer.

In BillQuick, activity and expense accounts are not required, except for the purpose of data integration with Sage 50. For all activity and expense codes in BillQuick, you can specify different G/L accounts. As activities, expenses and other items are part of an invoice, when you synchronize invoices with Sage 50, BillQuick assigns the specified G/L accounts to each item. Accordingly, the correct G/L accounts are updated in Sage 50 after sync. This tracks your company’s income and expenses in the accounting system.

Accounts for various BillQuick items can be set up in two ways:

- **Integration menu:** You can assign accounts to BillQuick activities and expenses, and other items via the BillQuick-Peachtree Sync Settings-Accounts screen. Sage 50 accounts are available for assignment after a connection between BillQuick and Sage 50 is established.

- **Sage 50:** If you integrate with Sage 50 and GET Service and Expense Items, the associated G/L accounts also transfer to BillQuick.

You can assign accounts to BillQuick items prior to sync with Sage 50 on the BillQuick-Peachtree Accounts screen. For description of each field on this tab, see the BillQuick Help.

To assign accounts to BillQuick items:

1. Open the BillQuick-Peachtree Sync Settings screen from the Integration menu, Peachtree Accounting.

2. Select the Accounts tab. Choose Default Accounts on the left.

3. Select the Default Accounts for each BillQuick item from the dropdown lists. Assign accounts to expenses, activities, invoices, vendor bills, purchase items and payments sent to Sage 50. You can also specify some of these accounts at the project level. **Project accounts will override the ones specified at this level.**
4. If you want to assign separate accounts to individual activity items, select Activity Accounts option on the left. Assign the desired G/L Income Account and Expense Account per item. These accounts override the default accounts specified earlier.
Similarly, you can specify individual accounts per expense item from the Expense Accounts panel.

5. Next, you can specify the Income Account and Expense Account for BillQuick services and expenses at the project or project group level. These accounts override any accounts specified previously but for the selected project(s) only.
Besides these accounts, you can also assign A/R (accounts receivable), A/P (accounts payable) and Cash Account so that transactions related to the selected projects will accordingly get posted to these accounts in Sage 50.

6. When done, click Save and then Close to exit.

Payroll Settings

Every payroll item must be assigned to an account in Sage 50. BillQuick allows you to assign Sage 50 payroll items and accounts to its time entry related items such as regular time, overtime, vacation, etc on an employee or employee group basis. The time data transferred will be assigned to the specified payroll item and account in Sage 50. For description of each field on this tab, see the BillQuick Help.
Initial Integration

Preferences controlling how BillQuick and Sage 50 work together are managed through the Sync Settings screen. It is accessed from the Integration menu, Peachtree Accounting. During integration setup and synchronization procedures, both BillQuick and Sage 50 must be running. Sage 50 allows only on-demand synchronization.

Security Permissions

Before you ask BillQuick to synchronize data with Sage 50, you (the user) must have security permission in BillQuick to perform the task. The BillQuick Supervisor in your company assigns security permissions to users.

Second, you must tell Sage 50 to allow direct communication with BillQuick. To do this, again you must have the security permissions. Once you do, you would set the security level for BillQuick (called a Peachtree Partner) on Sage 50’s Maintain Global Options screen.

With Medium security, for example, each time you synchronize data, Sage 50 prompts you to allow BillQuick to access your Sage 50 database (one currently open in Sage 50). Other options provide more or less open security access.
Scenario 1: Existing BillQuick-New Peachtree User

BillQuick users who are new to Sage 50 Accounting start by transferring information from BillQuick to a new Sage 50 database. After creating the Sage 50 file and setting synchronization preferences, you can initiate synchronization and check the transferred data.

Please follow the steps below to integrate BillQuick and Sage 50.

1. Sage 50 Database

Before integrating with BillQuick, a new Sage 50 user must first create a Sage 50 database and assign the Peachtree Partner security level (see Security Permissions above or Sage 50 Help for more).


   ![Create a New Company - Introduction](image)

   *Create a New Company*

   This wizard will walk you through creating a new company. You will be asked about your:

   - Company name and address
   - Business type
   - Accounting method (cash or accrual)
   - Accounting periods
   - Fiscal year

2. Enter company name, address and other details.
3. Select your business type and if you wish, let Sage 50 suggest a Chart of Accounts for your business type. If you already have a chart of accounts, enter them after exiting the wizard.

4. Enter your preferred accounting method, period and other financial data.

5. Enter the required information and exit the wizard.

6. Use the Sage 50 Setup Guide to customize company defaults and create company records.
2. Backup Database

For the first-time sync, it is important to back up your BillQuick database. Select BackUp Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company database (for example, the standard installation folder `x:\Program Files\BillQuick2012; x = drive letter`). If you want the database copy to be saved in another location, select Global Settings-Folders from the Settings menu and enter a new location.

3. Sync Settings

For BillQuick to know what data to transfer and other integration preferences, you need to define integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune Synchronization Settings below).
1. In BillQuick, look at the status line at the bottom. It displays the BillQuick database that is open. *If it is not the one you want to integrate with*, select File menu, Open Company. Choose the correct company, and then continue to the next step.

2. From the Integration menu, select Peachtree Accounting, Sync Settings.

3. Click the General tab. Select your Peachtree Version. Also, select the desired Sage 50 Company file from the drop-down list or click Browse to locate it.

4. Click the Connect button to establish a link to the Sage 50 database. If the Sage 50 application is not running, it starts automatically.

   You can see the location of the BillQuick Database that will integrate with Sage 50.

5. If you want to map the Sage 50 Cost Codes to BillQuick Activity/Expense Codes during sync, check that option at the bottom. See *General Settings* for more.

6. Click the Send Settings tab. In order, select each Module and assign desired settings to it.

7. You need to decide whether to send each type of BillQuick data to Sage 50. If you wish to restrict what data records transfer to Sage 50, choose one or more filters. See *Send Settings* for more information.
Initial Integration

The Get Settings tab is not used because we are sending data from BillQuick to populate a new Sage 50 database.

8. Click the Accounts tab.

In Sage 50, each item is associated with a general ledger (G/L) account. To ensure activities, expenses, invoices and other BillQuick items update the correct G/L account in Sage 50, specify their default accounts from the dropdown list. See Sage 50 Accounts for more.

9. Every payroll item in BillQuick must be assigned a number that will determine the order in which it will be listed in Sage 50’s Pay Types list. Select a number for the Default Payroll Item. See Payroll Settings for more.

10. If you want to specify the payroll settings for a specific Employee or Employee Group, select that option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 5 for Vacation, etc. This will override the default setting specified above.

   If you assign payroll settings to the Employee Group ‘ALL’, you no longer have to go back to Sync Settings screen every time you add a new employee in BillQuick.

11. Click Add to associate these BillQuick payroll items to the Sage 50 Pay Types and then click Save.

4. Send Data

Now you are ready to synchronize data with Sage 50.

1. From the Integration menu in BillQuick, select Peachtree Accounting, Send to Peachtree.

2. In turn, select each menu item, starting with Activity. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and Sage 50 and verify the data is complete. See Quick-Check for more information.
Repeat this step for the next menu item. Below are the BillQuick Send menu items and the corresponding Sage 50 screen.

<table>
<thead>
<tr>
<th>BillQuick Send Menu Item</th>
<th>Peachtree Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity*</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td>(Activity)</td>
</tr>
<tr>
<td>Expense Item*</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td>(Charge)</td>
</tr>
<tr>
<td>Employees*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Clients*</td>
<td>Customer</td>
</tr>
<tr>
<td>Projects*</td>
<td>Jobs</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Ticket</td>
</tr>
<tr>
<td>Expense Log</td>
<td>Expense Ticket</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoice</td>
</tr>
<tr>
<td>Payments</td>
<td>Receipts</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase Orders</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Vendor Bills</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Label feature.
5. Fine-Tune Synchronization Settings

After you check the data transferred to Sage 50, you may wish to change your integration settings to ones better suited for day-to-day synchronization. See Day-to-Day Integration Settings for more information.

Scenario 2: New BillQuick-Existing Peachtree User

Sage 50 users who are new to BillQuick start by transferring information from Sage 50 to a new BillQuick database. After creating the BillQuick Company and setting synchronization preferences, you can initiate synchronization and check the transferred data.

Please follow the steps below to integrate BillQuick and Sage 50.

1. **BillQuick Company**

   Before integrating, a new BillQuick user must first create a BillQuick company database. BillQuick requires security permission to perform this task (see Security Permissions above).

   1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish to use. If unsure, choose Standard.

      ![The database technology available to you depends on the BillQuick edition purchased. If you are unsure what edition you licensed, select About BillQuick from the Help menu. The edition abbreviation displays right after the version number.]

      | Edition            | Database Technology                   |
      |--------------------|---------------------------------------|
      | BillQuick Basic    | Microsoft Access (Standard)           |
      | BillQuick Pro      | Microsoft Access                      |
      |                    | Microsoft SQL Express                 |
      | BillQuick Enterprise| Microsoft Access                      |
      |                    | Microsoft SQL Express                 |
      |                    | Microsoft SQL Server                  |

   2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the company name is used for easy identification. Click the Open button. BillQuick creates the database and opens the BillQuick Startup Interview wizard.

      ![The BillQuick Start-Up Interview can be closed and reopened later. To do so, select Wizards, BillQuick Interview from the View menu.]

   3. On the BillQuick Start-Up Interview panel, click the Next button.
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity (service) and expense codes into your firm database. These codes are not needed because items will transfer from Sage 50 into BillQuick. Click the Next button.

5. Custom Labels allow you to customize key business terms to your profession and firm-preferred terminology in BillQuick. Customizing terms eases transition from your old time and billing solution. Select your preferred terms from the drop-down lists. When done, click the Next button.

6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your License and Registration (or Evaluation) Key email.

7. Click the Next button to accept the defaults on the remainder of the panels. You can update these options later on the Global Settings and User Preferences screen. On the last panel, click the Finish button.

8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to create master information; setting up basic employee, client, project, etc, confirming the actions using the checklists. When done, click the Close button.
9. The Company screen displays. Either complete the fields now and click the Save button when done; or click the Close button and perform this task later.

10. From the File menu, select Login. For User ID, type 'supervisor' (without quotes), then for password, type 'supervisor' (without quotes). This gives you full security permissions in BillQuick to perform integration tasks.

2. Backup Database

For the first-time sync, it is important to back up your Sage 50 database. Select Back Up from the File menu. Click on the Back Up button on the dialog to make a copy of your database.
3. Sync Settings

For BillQuick to know what data to transfer and your other integration preferences, you need to define sync settings. Later, you can fine-tune these settings for day-to-day integration (see 5. Fine-Tune Synchronization Settings below).

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open BillQuick database. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company, and then continue to the next step.

2. From the Integration menu, select Peachtree Accounting, Sync Settings.

3. Click the General tab. Select your Peachtree Version and the desired Sage 50 Company file from the drop-down list or click Browse to locate it.

4. Click the Connect button to establish a link to the Sage 50 database. If the Sage 50 application is not running, it starts automatically. At the bottom, it displays the location of the BillQuick Database that will integrate with the Sage 50 data. See General Settings for more.

5. Click the Get Settings tab. In order, select each Module and assign desired settings to it.

6. In most cases, you only need to decide whether to get each type of Sage 50 data. If you wish to restrict what data records transfer from Sage 50, choose one or more filters. See Get Settings for more information.
4. Get Data

Now you are ready to transfer data from Sage 50 to BillQuick.

1. From the Integration menu in BillQuick, select Peachtree Accounting, Get from Peachtree.

2. In turn, select each menu item, starting with Service Items. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and Sage 50 and verify the data is complete. See Quick-Check section for more information.

Bill Rate and Cost Rate in employee records must be updated before synchronizing time records. Special bill rates/cost rates associated with work done by employees on a project must be defined in a Service Fee Schedule and assigned to the project before synchronizing time records.
Repeat this step for the next menu item. Below are the BillQuick Get menu items and the corresponding Sage 50 screen.

<table>
<thead>
<tr>
<th>BillQuick Get Menu Item</th>
<th>Peachtree Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Items*</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td>(Activity)</td>
</tr>
<tr>
<td>Charge Items*</td>
<td>Inventory Item</td>
</tr>
<tr>
<td></td>
<td>(Charge)</td>
</tr>
<tr>
<td>Employees*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Clients*</td>
<td>Customer</td>
</tr>
<tr>
<td>Jobs*</td>
<td>Jobs</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Ticket</td>
</tr>
<tr>
<td>Expense Log</td>
<td>Expense Ticket</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoice</td>
</tr>
<tr>
<td>Payments</td>
<td>Receipts</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase Orders</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Vendor Bills</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Label feature.

5. Fine-Tune Synchronization Settings

Data touchup is needed in BillQuick after getting data from Sage 50 because BillQuick requires certain fields which might be optional in Sage 50.

After you check the data transferred to BillQuick, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings for more information.

Scenario 3: New BillQuick-New Peachtree User

If you are new to both BillQuick and Sage 50 Accounting, you need to set up company databases in both applications, enter and/or import master information in BillQuick (or Sage 50), then synchronize the data with the other application.

To gain the most complete and useful practice management information from the start and reduce setup time, we recommend that you add or import all master information and other time and billing data into your BillQuick firm database, then synchronize it with Sage 50.
BillQuick’s Import/Export function (Utilities menu) reads data in Comma Separated Value (comma delimited) or Tab Delimited files. In this utility, you can associate each data field with the corresponding one in BillQuick. If your old application exports data to a comma- or tab-delimited file format, or to Microsoft Excel (which can save data in these file formats), you can reduce setup time.

I. BillQuick Company Database

Before integrating, a new BillQuick user must first create a new BillQuick company database. BillQuick requires security permission to perform this task (see Security Permissions above).

1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish to use. If unsure, choose Standard.

The database technology available to you depends on the BillQuick Edition purchased. If you are unsure what edition you licensed, select About BillQuick from the Help menu. The edition abbreviation displays right after the version number.

<table>
<thead>
<tr>
<th>Edition</th>
<th>Database Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>BillQuick Basic</td>
<td>Microsoft Access (Standard)</td>
</tr>
<tr>
<td>BillQuick Pro</td>
<td>Microsoft Access</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Express</td>
</tr>
<tr>
<td>BillQuick Enterprise</td>
<td>Microsoft Access</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Express</td>
</tr>
<tr>
<td></td>
<td>Microsoft SQL Server</td>
</tr>
</tbody>
</table>

2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the company name is used for easy identification. Click the Open button. BillQuick creates the database and opens the BillQuick Startup Interview wizard.

The BillQuick Start-Up Interview can be closed and reopened later. To do so, select Wizards, BillQuick Interview from the View menu.

3. On the BillQuick Start-Up Interview panel, click the Next button.

4. For the Business Type, you would select a type if you want BillQuick to copy default industry-specific activity (service) and expense codes into your firm database. If you wish to use your own set of codes, leave the field blank and click the Next button.

5. Labels allow you to customize key business terms to your profession and firm-preferred terminology in BillQuick. Customizing terms eases transition from your old time and billing solution. If you selected a business type on the previous panel, common terms or custom labels display for your profession. If you left business type blank, these fields will be blank too. To select a BillQuick label, click the drop-down. When done, click the Next button.
6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your License and Registration (or Evaluation) Key or email.

7. Click the Next button to accept the defaults on the remainder of the panels. You can update these options later on the Global Settings and User Preferences screen. On the last panel, click the Finish button.

8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to create master information; setting up basic employee, client, project, etc., confirming the actions using the checklists. When done, click the Close button.
9. The Company screen displays. Either enter data now and click the Save button when done, or click the Close button and perform this task later.

10. From the File menu, select Login. For User ID, type 'supervisor' (without quotes), then for password, type 'supervisor' (without quotes). This gives you full security permissions in BillQuick to perform integration tasks.

2. Sage 50 Database

A new Sage 50 user must first create a Sage 50 database and assign the Peachtree Partner security level (see Security Permissions above).

![Create a New Company - Introduction](image1)

Create a New Company

This wizard will walk you through creating a new company. You will be asked about your:

- Company name and address
- Business type
- Accounting method (cash or accrual)
- Accounting periods
- Fiscal year

![Create a New Company - Company Information](image2)

Enter your company information

* Company Name: Stone Arbor Landscaping
  Address Line 1: ABC street
  Address Line 2: 
  City, State, Zip: Torrance, CA 90505
  Country: USA
  Telephone: 310-432-6789

Business Type: Corporation
  Federal Employer ID: 345236778444
  State Employer ID: 
  St. Unemployment ID: 
  Web Site: www.sal.com
  E-mail: 

Note: You can edit this information after your company is created.

2. Enter company name, address and other details.

3. Select your business type and if you wish, let Sage 50 suggest a Chart of Accounts for your business type. If you already have a chart of accounts, enter them after exiting the wizard.
4. Enter your preferred accounting method, period and other financial data.

5. Enter the relevant information and exit from the wizard.

6. Use the Setup Guide to customize company defaults and create company records.
1. Master information should be set up or imported first. In BillQuick, this data includes (View menu) Employee, Clients, Activity Codes, and Expense Codes. If you have subcontractors or consultants for whom you record time or expenses, also set up Vendors. Other types of master information can be added later.

When setting up new records, you only need to enter data into a few required fields. *All required fields have BLUE field labels.* Other data can be entered now or later.

2. The term 'project' may be changed in BillQuick to Engagement, Matter, Job, Work Order or any other term you prefer. Phases and segments are sub-projects or detailed breakdowns of work being done for a client.

Projects represent the scope of work or type of service performed for a client. Each project record contains contract, billing arrangement, budget, special billing rate, and other elements that control how BillQuick adapts to your firm and processes data. When billing, BillQuick automatically organizes information by project (with the option to create one invoice per project or one invoice for all of a client’s projects), making it easier and faster to bill clients. Also, practice management information is more detailed and readily available by project.

An accountant, for instance, may deliver tax, write-up, payroll and consulting services to a client, each billed differently (fixed fee, recurring monthly fee, hourly), and possibly, at different bill rates for the same employees doing the work. An attorney may handle contract, litigation, real estate, and other matters for a client, and again elements of the relationships may vary. Architects and engineers often break down projects into phases, assigning a portion of the contract amount and/or budget to the phase of work.

Add Project records, and as needed, project phases and segments.

*The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Label feature.*
3. Determine what time records (e.g., timesheets, daily diaries, time entries in your old time and billing application) and expenses (e.g., expense reports) are unbilled. Manually enter or import these records into BillQuick.

Before entering time records, review each employee record in BillQuick to make sure the Bill Rate and Cost Rate is correct. Also, if special bill rates (and special cost rates) apply to work done by employees on a project, be sure to define an appropriate Service Fee Schedule and assign it to related projects before entering time records. BillQuick uses these rates to calculate the bill amount and cost amount of time records.

To manually enter time records, select Sheet View or Simple Time Card from the Time-Expense menu. Each time record for an employee requires a date, project to be charged, activity code, and hours. A memo or extended note is optional.

BillQuick supports Control Hours. To activate the feature, check the option on the Sheet View screen. It warns you if the hours entered during a session are different from the control hours.

To manually enter expense records into BillQuick, Select Expense Log or Simple Expense Log from the Time-Expense menu. Each expense record for an employee requires a date, project to be charged, expense code, units, and as needed, cost and markup (when a default is not part of the expense code). A memo or extended note is optional.

4. When recording old invoices in BillQuick, you have several options:

- ‘Project’ detailed invoices – previous project invoices sent to clients. You can enter only outstanding (unpaid) invoices, or invoices going back as long as you want practice management information available. See A below.
- ‘Client’ detailed invoices – previous invoices sent to a client for all work done that is not broken out by project. See B below.
- Balance forward invoices – summary amount by client for all outstanding invoices. See C below.

**A. To enter detailed invoices by project. . .**

1. Select Manual Invoice from the Billing menu.
2. Select the ID of the project to which the invoice applies.
3. In the Description field, enter a brief description or explanation for the services billed in your old system and the total for the services from the old invoice. On the next line, do the same for expenses and check the Exp box.
4. Verify that Amount Due at the bottom of the screen matches the old invoice.
5. Click the Process button.
6. Repeat for each detailed project invoice.

**B. To enter detailed invoices by client. . .**

1. Select Project Information from the Project menu.
2. Click the New button.
3. Enter a unique Project ID that identifies the project record as existing only for detailed client invoices. Fill in the required fields and click the Save button.
4. Click the Clone button, select the ID of the project you just defined from the drop-down list, check the 'Clone for Selected Clients' box, and select the clients for whom you want to add detailed client invoices. Click the OK button. Close the Project screen.
5. Select Manual Invoice from the Billing menu.
6. Select the ID of the first ‘client invoices’ project.
7. In the Description field, enter a brief description or explanation for the services and the total amount for all services from the old invoice. On the next line, do the same for expenses and check the Exp box.
8. Verify that the Amount Due at the bottom of the screen matches the old invoice.
9. Click the Process button.
10. Repeat for each detailed client invoice.

C. To enter balance forward invoices by client.

1. Select Project Information from the Project menu.
2. Click the New button.
3. Enter a unique Project ID that identifies the project as existing only for balance forward amounts. Fill in the other required fields and click the Save button.
4. Click the Clone button, select the ID of the project you just defined from the drop-down list, check the 'Clone for Selected Clients' box, and select the clients for whom you want to add balance forward amounts. Click the OK button. Close the Project screen.
5. Select Manual Invoice from the Billing menu.
6. Select the ID of the first ‘balance forward’ project.
7. In the Description field, enter a brief description such as ‘Balance Forward for Client ABC’ and the total service amount for all outstanding invoices. On the next line, do the same for expenses and check the Exp box.
8. Verify that Amount Due at the bottom of the screen matches the summary balance.
9. Click the Process button.
10. Repeat the steps above for each balance forward invoice.

Alternatively, you can enter opening balances for each project in the Opening Balances screen available from the Project-History screen. It automatically creates a manual invoice for you. See BillQuick Help for more.

5. If you entered any paid invoices, you need to record the associated payment (cash receipt) to bring it to ‘paid’ status in BillQuick. Select Payments from the Billing menu and record cash receipts, credit memos, and other items for each invoice. Retainer amounts and amounts on account can also be recorded on the Payment screen, either to the client or to a specific project.

If you entered only outstanding invoices or balance forward amounts, you can move to the next step.
4. Sync Settings

Now that you have data set up in BillQuick, you need to transfer it to Sage 50 Accounting so that both applications begin processing from the same point. For BillQuick to know what data to transfer and your other integration preferences, you need to define integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune Synchronization Settings below).

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open BillQuick database. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company, and then continue to the next step.

2. From the Integration menu, select Peachtree Accounting, Sync Settings.

3. Click the General tab. Select your Peachtree Version and the desired Sage 50 Company file from the drop-down list or click Browse to locate it.

4. Click the Connect button to establish a link to the Sage 50 database. If the Sage 50 application is not running, it starts automatically.

   At the bottom, it displays the location of the BillQuick Database that will integrate with Sage 50.

5. If you want to map the Sage 50 Cost Codes with the BillQuick Activity/Expense Codes during sync, check that option at the bottom. See General Settings for more.
6. Click the Send Settings tab. In order, select each Module and assign desired settings to it.

7. You only need to decide whether to send each type of BillQuick data to Sage 50. If you wish to restrict what data records transfer to Sage 50, choose one or more filters. See Send Settings for more information.

   The Get Settings tab is not used because we are sending data from BillQuick to populate a new Sage 50 database.

8. Click the Accounts tab.

   In Sage 50, each item is associated with a general ledger (G/L) account. To ensure activities, expenses, invoices and other BillQuick items update the correct G/L account in Sage 50, specify their default accounts from the dropdown list. See Sage 50 Accounts for more.

9. Every payroll item in BillQuick must be assigned a number that will determine the order in which it will be listed in Sage 50’s Pay Types list. Select a number for the Default Payroll Item. See Payroll Settings for more.

10. If you want to specify the payroll settings for a specific Employee or Employee Group, select that option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 5 for Vacation, etc. This will override the default setting specified above.

   If you assign payroll settings to the Employee Group ‘ALL’, you no longer have to go back to Sync Settings screen every time you add a new employee in BillQuick.

11. Click Add to associate these BillQuick payroll items to the Sage 50 Pay Types and then click Save.

4. Send Data

Now you are ready to synchronize data with Sage 50.

1. From the Integration menu in BillQuick, select Peachtree Accounting, Send to Peachtree. Repeat this step for the next menu item.
Below are the BillQuick Send menu items and the corresponding Sage 50 screens.

<table>
<thead>
<tr>
<th>BillQuick Send Menu Item</th>
<th>Peachtree Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity*</td>
<td>Inventory Item (Activity)</td>
</tr>
<tr>
<td>Expense Items*</td>
<td>Inventory Item (Charge)</td>
</tr>
<tr>
<td>Employees*</td>
<td>Employee</td>
</tr>
<tr>
<td>Vendors*</td>
<td>Vendor</td>
</tr>
<tr>
<td>Clients*</td>
<td>Customer</td>
</tr>
<tr>
<td>Projects*</td>
<td>Jobs</td>
</tr>
<tr>
<td>Time Entry</td>
<td>Time Ticket</td>
</tr>
<tr>
<td>Expense Log</td>
<td>Expense Ticket</td>
</tr>
<tr>
<td>Invoices</td>
<td>Invoice</td>
</tr>
<tr>
<td>Payments</td>
<td>Receipts</td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td>Chart of Accounts</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase Orders</td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>Vendor Bills</td>
</tr>
</tbody>
</table>

* The screen name may be different based on your profession or industry, or if you customized them using BillQuick’s Custom Label feature.
6. Fine-Tune Synchronization Settings

After you check the data transferred to Sage 50, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings for more information.

Scenario 4: Existing BillQuick-Existing Peachtree User

Typically, a company utilizes BillQuick to manage projects, enter time, generate invoices, record payments, and produce reports. Sage 50 is utilized for accounting tasks such as payroll, accounts payable, financial reports and so on. If you have been using both BillQuick and Sage 50, and want the two applications to be able to share data, you need to develop a proper integration plan. This plan should take into consideration what data (if any) has been transferred between the applications in the past, either manually or via Import/Export facility. Based on this, your initial integration steps may vary.

1. Open Database

Since you have data in both BillQuick and Sage 50, you need to open both applications. Ensure that the company databases that you wish to synchronize are open.

2. Backup Data

Next, back up both BillQuick and Sage 50 databases. To back up the BillQuick Database, select BackUp Database from the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company database (for example, the standard installation folder x:\Program Files\BillQuick2012; x = drive letter). If you want the database copy to be saved in another location, select Global Settings-Folders screen from the Settings menu and enter a new location.

Select Back Up from the File menu. Click on the Back Up button on the dialog.

3. Sync Settings

Existing users have the option to send and get data as per their needs and business practice. What data is to be transferred depends on how you have been previously keeping your data in both applications. Some of the records being transferred between the two may already be present in the other database. In this case, the duplicates need to be merged.

   1. Open the BillQuick application.

   2. Look at the status line at the bottom of the BillQuick screen. It displays the currently open BillQuick database. If it is not the one you want to integrate with, select File menu, Open Company. Choose the correct company and then continue to the next step.

   3. Start Sage 50 and open the database that you wish to integrate with BillQuick.
4. From the BillQuick Integration menu, select Peachtree Accounting, Sync Settings. The BillQuick-Peachtree Sync Settings screen displays.

5. Click the General tab. Select your Peachtree Version. Also, select the desired Sage 50 Company file from the drop-down list or click Browse to locate it.

6. Click the Connect button to establish a link to the Sage 50 database. If the Sage 50 application is not running, it starts automatically.

   You can see the location of the BillQuick Database that will integrate with the Sage 50.

7. If you want to map the Sage 50 Cost Codes to BillQuick Activity/Expense Codes during sync, then check that option at the bottom. See General Settings for more.

8. Determine what data you want to get from Sage 50 and what data to move into Sage 50. Accordingly, select the Send Settings or Get Settings tab. You can specify various filters and other options for each module selected from the list on the left. See Get Settings for more.

   🛍️ You should send approved time entries to Sage 50 only if you do payroll there.

   🛍️ If you have created invoices and payments in Sage 50 only, you should move the clients, projects and employees from BillQuick to Sage 50. Once these records are moved, you can then link the Sage 50 invoices and payments to these projects (jobs).
Initial Integration

9. Click the Accounts tab. In Sage 50, each item is associated with a general ledger (G/L) account.

   To ensure activities, expenses, invoices and other BillQuick items update the correct G/L account in Sage 50, you must specify their default accounts from the dropdown list. See Sage 50 Accounts for more.

10. Every payroll item in BillQuick must be assigned a number that will determine the order in which it will be listed in Sage 50’s Pay Types list. Select a number for the Default Payroll Item. See Payroll Settings for more.

11. If you want to specify the payroll settings for a specific Employee or Employee Group, select that option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 5 for Vacation, etc. This will override the default setting specified above.

   If you assign payroll settings to the Employee Group ‘ALL’, you no longer have to go back to Sync Settings screen every time you add a new employee in BillQuick.

12. Click Add to associate these BillQuick payroll items to the Sage 50 Pay Types and then click Save.

4. Sync Data

Now you are ready to synchronize data between BillQuick and Sage 50.

   If you are trying to integrate a BillQuick Sample database with Sage 50, you will be warned prior to the sync.

1. From the Integration menu, Peachtree Accounting in BillQuick, select an appropriate option - Send to Peachtree or Get from Peachtree.

2. In turn, select each menu item, starting with Activity/Service Items. After the progress bar indicates that the transfer is complete, open the corresponding screens in BillQuick and Sage 50 and verify whether the data is complete. See Quick-Check for more information.

   Repeat this step for the next menu item. Below are the BillQuick Send/Get menu items and the corresponding Sage 50 screen.
5. Match Data

In case of existing BillQuick and Sage 50 users, it is likely that duplicate records are found in the other application. This duplication arises because of separate entry of data in the two applications, even for similar records. The matching of these records can be a time consuming process. However, you will need to do it only once and then from that point onwards, data sync can be scheduled accordingly. To save time, you can skip matching of inactive records.

During data sync process, BillQuick will either overwrite the duplicate data or leave it as is, depending upon the Overwrite Rules specified in the BillQuick-Peachtree Sync Settings screen.

You can manually check and merge the duplicate data in any of the applications. The records that were moved from BillQuick to Sage 50 should stay and the Sage 50 records can be deleted after you have copied that data to the records created by BillQuick. The main reason for keeping the BillQuick-created records is that BillQuick maintains a link between the two applications after the first sync. This PTLinkID helps to update the two records in the future.

Alternatively, you can make use of BillQuick’s Smart Match feature to link similar records or unlink different records. With this feature, BillQuick attempts to find matching data (both active as well as inactive) and link them automatically. If it fails to find a match, you can match it manually.

You can view both BillQuick and Sage 50 data on the BillQuick↔Peachtree Smart Match screen.
Depending upon the option selected in the Data field in the button panel, the data records will be displayed in grids, separately for BillQuick and Sage 50. E.g., if you select Activity Codes in the Data field, you can view activity data already matched between the two applications on the Matched tab. The grid will display BillQuick records and corresponding matched Sage 50 records. If needed, you can select the matched records and then un-match them using the UnLink button. Similarly, on the Unmatched tab, you will see unmatched data between the two applications. If needed, you can select the unmatched records and then match them using the Link button.

6. Fine-Tune Synchronization Settings

Data touchup is needed in BillQuick after getting data from Sage 50 because BillQuick requires certain fields which might be optional in Sage 50.

After you check the data transferred to/from Sage 50, you may wish to change your integration settings to ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings.
A standard procedure after initial synchronization of data between BillQuick and Sage 50 Accounting is to check data. This ensures transferred data is accurate and complete.

BillQuick contains multiple processes to ensure accurate and complete transfer of data. However, you may find that a setting in Sage 50 may have restricted transfer of data. Or you may have inadvertently checked a filter on the Sync Settings screen. Checking data before you begin normal processing ensures no surprises later.

After synchronizing, go to the section below for the type of data and follow the suggested instructions.

1. **Check Activity and Expense Codes**

   **Detailed Checking**

   1. In Sage 50, select Inventory Items from the Maintain menu.
   2. In BillQuick, select Activity Codes from the View menu.
Quick Check

3. Switch between the applications, selecting the same activity item in both and checking that the data is same.
4. Repeat this for Expense Codes. In BillQuick, select Expense Codes from the View menu. Compare the records to Inventory Charge Items in Sage 50.

Summary Checking

1. In Sage 50, select Reports & Forms menu, Report Groups. From the ‘Select a Report or Form’ screen, select Inventory on the left. Select and double-click Item List to display that report (if desired, you can print the report).
2. In BillQuick, select Activity Master File report from the Activity Codes screen. Else open it from the Reports menu, Activity.
3. Compare the two lists to ensure all the activities are transferred.
4. Repeat steps 2 and 3 for Expense Codes.

2. Check Employees

Repeat the above process for employee data. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Maintain menu, Employees/Sales Reps. In BillQuick, select View menu, Employees. Compare the employee list in both screens.
Quick Check

For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Payroll; then double-click Employee List. In BillQuick, select Reports menu, Employee and open the Employee Master File report. Compare the data in the two reports.

Before entering time records, or transferring time records from Sage 50, review each employee record in BillQuick to make sure the Bill Rate and Cost Rate are correct. Also, if special bill rates (and special cost rates) apply to work done by employees on a project, be sure to define an appropriate Service Fee Schedule and assign it to related projects before entering or transferring time records. BillQuick uses these rates to calculate the bill amount and cost amount of time records.

3. Check Vendors

Repeat the above process for vendor data. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Maintain menu, Vendors. In BillQuick, select View menu, Vendors. Compare the vendor list in both screens.

For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Accounts Payable; then double-click Vendor List. In BillQuick, select Reports menu, Report Center and open the Vendor List report. Compare the data in the two reports.

On the BillQuick Vendor screen, determine which of the vendors transferred from Sage 50 (if any) should be deleted. Select the vendor from the grid, verify you selected the correct vendor and click the Delete button.

If you enter time records for vendors (subcontractor or consultants) in BillQuick, be sure to change the Bill and Cost Rates. When transferred from Sage 50, BillQuick inserts $0 as placeholder values in vendor records.

4. Check Clients/Customers

Repeat the above process. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Maintain menu, Customers/Prospects. In BillQuick, select View menu, Client. Compare the client list in both screens.
For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Accounts Receivables; then double-click Customer Master File List. In BillQuick, select Reports menu, Client and open the Client Master File report. Compare the data in the two reports.

5. **Check Projects/Jobs**

Repeat the above process. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Maintain menu, Job Costs, Jobs. In BillQuick, select Project menu, Project Information. Compare the project list in both screens.
For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Job Reports; then double-click Job Master File List. In BillQuick, select Reports menu, Project and open the Project Master File report. Compare the data in the two reports.

**Special Note**

BillQuick is project-centric. Each project is associated with a client. Time and expenses are charged to a project, and bills are generated by project (though multiple bills can appear on a joint invoice).

In Sage 50 you may have billed customers rather than jobs (projects). If so, no projects appear in BillQuick because there are no jobs to transfer. Similarly, if you billed some jobs and some customers, only the existing jobs transfer to BillQuick.

However, BillQuick automatically creates projects on-the-fly when you transfer customer invoices from Sage 50. The Project ID is based on the Client ID. Also, because Project Manager is a required field in BillQuick, and there is no corresponding field in Sage 50, BillQuick creates a new employee record with placeholder values, ‘FromPeachtree’. This maintains data integrity in BillQuick. You can decide who is responsible for each project/job later.

**Bottom Line:** You may need to repeat this quick-check step after synchronizing Sage 50 invoices to BillQuick.
6. Check Time Entries

Repeat the above process for time entries. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Lists menu, Time/Expense, Time Tickets. In BillQuick, select Time-Expense menu, Enter Time, Sheet View. Compare the time entries in both screens.

For summary checking, in Sage 50 select Reports & Forms menu, Report Groups Time/Expense Reports; then double-click Payroll Time Sheet. In BillQuick, select a time entry report from the Reports menu or Report Center. Compare the data in the two reports.

7. Check Expense Entries

Repeat the above process. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Lists menu, Time/Expense, Expense Tickets. In BillQuick, select Time-Expense menu, Enter Expense, Expense Log. Compare the expense entries in both screens.

For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Time/Expense Reports; then double-click Expense Ticket Register. In BillQuick, select an expense entry report from the Reports menu or Report Center. Compare the data in the two reports.
8. Check Invoices

Repeat the above process for invoices. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Lists menu, Customers & Sales, Sales Invoices. In BillQuick, select Billing menu, Review Invoices, Invoice Review. Compare the invoices in both screens.

For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Accounts Receivable; then double-click Invoice Register. In BillQuick, select Reports menu, Billing and open the Invoice Register. Compare the data in the two reports.

9. Check Payments

Repeat the above process for payments. Use the Detailed Checking or Summary Checking method.

For detailed checking, in Sage 50 select Lists menu, Customers & Sales, Receipts. In BillQuick, select Billing menu, Receive Payments, Payments. Compare the payments in both screens.
For summary checking, in Sage 50 select Reports & Forms menu, Report Groups, Accounts Receivable; then double-click Cash Receipts Journal. In BillQuick, select Reports menu, Payments and open the Cash Receipts Journal report. Compare the data in the two reports.
Day-to-Day Integration Settings

After completing initial synchronization, review current settings to determine if they should be fine-tuned for day-to-day processes.

It is a good practice to maintain clients, projects, time and expenses, billing, accounts receivables, payments and reports in BillQuick. Sage 50 should be used for functions such as accounts payable, general ledger, banking, payroll and financial statements. The following illustration gives an idea about the common breakdown of tasks you should be doing in BillQuick and Sage 50.

![Common Task Breakdown](image)

Below are situations to consider for each type of data and also the best practices followed in the industry.

Please check the Integration Rules for underlying rules and details about BillQuick ↔ Peachtree Integration.

**Master Information**

Consider where you want to save each type of master information – activity codes, expense codes, employees, clients, and projects. When you add, edit or delete records, do you want this task done in BillQuick, in Sage 50, or both?
Commonly, companies maintain project records in BillQuick only. This is the core information essential to effective practice management and maintaining it in BillQuick is appropriate. Hence, it is better to create and maintain that data in BillQuick and send it to Sage 50.

However, it is a good practice to create activity and expense (other charge) items in Sage 50 because appropriate G/L accounts are assigned to them there. It is easier to transfer these items into BillQuick along with their G/L accounts. To enforce this policy, you should accordingly ‘turn on’ getting this data from Sage 50. This can be done in the BillQuick↔Peachtree Sync Settings screen by selecting the desired module and un-checking the ‘Do Not Get’ option.

Where you maintain client (customer) records depends on your situation.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Sync Setting</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require extensive customer information (e.g. sales and payment defaults)</td>
<td>From Send Settings list, select Client and check the ‘Do Not Send’ box.</td>
<td>Maintain customer records in Sage 50. Get updated records from Sage 50 as needed.</td>
</tr>
<tr>
<td>Require typical customer information</td>
<td>From the Get Settings list, select Client and check the ‘Do Not Get’ box</td>
<td>Maintain client records in BillQuick. Send updated records to Sage 50 as needed.</td>
</tr>
<tr>
<td>Desire convenience of update data common to BillQuick and Sage 50, or</td>
<td>From the Send Settings and Get Settings list, select Client and make sure both</td>
<td>Synchronize as needed.</td>
</tr>
<tr>
<td>want to enter data in either system</td>
<td>‘Do Not...’ boxes are unchecked.</td>
<td></td>
</tr>
</tbody>
</table>

Decisions about employees follow a similar process.

**Time Records**

You can record all time entries in BillQuick or one of its add-on modules and then send it to Sage 50 via integration. Whether you transfer time records from Sage 50 or not, time entries from employees (and vendors/consultants) should be entered in BillQuick. It is designed for maximum data entry efficiency and maximum flexibility (4 built-in ways to manage time, plus 5 ways to capture your hours remotely). BillQuick also includes numerous time and expense/work-in-progress reports.

If you do payroll through Sage 50, you would send time records to Sage 50. Make sure the ‘Do Not Send’ box for Time Entry is unchecked for Send Settings option in BillQuick-Peachtree Sync Settings screen. BillQuick Time Entries become Sage 50 Time Entries.

If payroll is not done through Sage 50, then there is no reason to send time entries to it. Check the ‘Do Not Send’ option for time entries.

For payroll done using other applications, you can export time entries using BillQuick’s Import/Export feature (Utilities menu).
When you integrate with Sage 50, a flag can be associated with a payroll item. For example, if you track hours as well as piecework in BillQuick and pass both types of hours to Sage 50, the hourly work might be associated with the regular pay item and piece work with another payroll item. Whether time entries flow to Sage 50, depends on your situation.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use hours to process payroll</td>
<td>Transfer time entries to Sage 50. Block time entries flowing from Sage 50 into BillQuick.</td>
</tr>
<tr>
<td>Do not use hours to process payroll</td>
<td>Do not transfer time entries to Sage 50. Block time entries flowing from Sage 50 into BillQuick.</td>
</tr>
<tr>
<td>Use hours for special analysis</td>
<td>Determine whether you analyze time (a) as a custom BillQuick report, (b) when exported to Excel, or (c) through Sage 50. If (c) then follow the first suggestion above.</td>
</tr>
</tbody>
</table>

However, there are some integration rules that limit the re-sending of the same time data to Sage 50. For example, if you send a time entry to Sage 50 (say for 40 hours) and then change it in BillQuick, it cannot be re-sent as it creates duplicate hours. Even if you delete it in Sage 50, it cannot be re-sent from BillQuick because it has already established a Link ID for it.

### Expense Records

You can record expenses in BillQuick or Sage 50. There is no duplication of data involved in the integration process between BillQuick and Sage 50. However, Sage 50 does not accept negative expenses. To transfer expenses to/from BillQuick, make sure the Do Not Get/Send box for Expenses is used accordingly.

❗ If you send invoices with negative line items from BillQuick, the total of all line items has to be positive for data transfer to Sage 50.

Whether you process reimbursable expenses to employees (e.g., travel, mileage) and other items chargeable to project (e.g., vendor invoices, materials) in BillQuick or in Sage 50 depends on the accounting software you use and your company procedures.
### Day-to-Day Integration Settings

<table>
<thead>
<tr>
<th>Situation</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record employee and vendor expenses in BillQuick</td>
<td>1. Enter expenses in Expense Log. Mark the ‘R’ box.</td>
</tr>
<tr>
<td></td>
<td>2. Review and approve expenses. Adjust markups and charge amounts as needed.</td>
</tr>
<tr>
<td></td>
<td>3. Synchronize the expenses with Sage 50 from the Integration menu.</td>
</tr>
<tr>
<td></td>
<td>4. Cut checks for employee and vendor reimbursements when ready.</td>
</tr>
<tr>
<td>Record expenses in BillQuick and reimbursable expenses in Sage 50</td>
<td>1. Enter copies, faxes and other resource usage expenses in BillQuick.</td>
</tr>
<tr>
<td></td>
<td>2. Record reimbursable expenses for employees and vendors in Sage 50 (e.g., from expense reports, download credit card statements) and assign to jobs.</td>
</tr>
<tr>
<td></td>
<td>3. Synchronize BillQuick and Sage 50 expenses using the Integration menu.</td>
</tr>
<tr>
<td></td>
<td>4. Cut checks for employee and vendor reimbursements when ready.</td>
</tr>
<tr>
<td>Record expenses in Sage 50</td>
<td>1. Enter expenses in Sage 50.</td>
</tr>
<tr>
<td></td>
<td>2. Synchronize them with BillQuick using the Integration menu.</td>
</tr>
<tr>
<td></td>
<td>3. Review and approve expenses on Expense Log, adjusting markups and charge amounts as needed.</td>
</tr>
<tr>
<td></td>
<td>4. Cut checks for employee and vendor reimbursements when ready.</td>
</tr>
</tbody>
</table>

Although you can send both Expense Log entries and vendor bills from BillQuick to Sage 50, but Sage 50 accepts them only as vendor bills. When you are sending employee expenses to Sage 50 as bills, BillQuick prompts you to predefine the Employee ID to Vendor ID switch. You can choose whether it is for all expenses or not, and specify the switch for different expenses. BillQuick can remember those settings and accordingly change the Employee ID to Vendor ID during the current sync and in future.

BillQuick vendor bills have a unique Bill No. (maximum length = 50 characters) and Reference No. (maximum length = 60 characters) while Sage 50 has an Invoice No. (maximum length = 20 characters) only. BillQuick maps its Bill No. to Sage 50's Invoice No.

Typically, you may enter the vendor's invoice number in BillQuick's Bill No. field. To avoid duplicate bill numbers, you can append it with a date or ID. E.g., if you received a bill from a vendor named ABC on May 18, 2012, with invoice number 2000, you can enter it as 2000-051812. Some of you may prefer to prefix it with the Vendor ID. Then it would be ABC-2000.

### Invoice Records

Creating invoices in BillQuick is the best course of action because it provides details critical to effective practice management. The most common synchronization setting for invoices is to send invoices from BillQuick to Sage 50 (‘Do Not Send box’ is unchecked and the ‘Do Not Get box’ is checked in the BillQuick-Peachtree Sync Settings screen).
There can be an exception to this situation. For example, if you generate product invoices in Sage 50 and you want to record payments for all invoices, then you would not turn off getting invoices from Sage 50.

Generally, invoices with zero value ($0) do not transfer from BillQuick to Sage 50. You may generate zero dollar invoices in BillQuick in various ways:

- You may manually adjust the New Bill value to $0 in the Billing Review screen.
- You may generate a write-down on the invoice to $0 in the Time Entry or Billing Review screen.
- You may generate a manual invoice with a $0 value in the Manual Invoice screen.
- You may apply a huge discount to the bill amount, bringing down the Net Bill to $0 in the Manual Invoice or Billing Review screen.
- You may apply a retainer to the invoice, totally the Net Bill to $0 in the Manual Invoice or Billing Review screen.

The only exception to transferring a zero dollar invoice is in case of discounts and retainers. You can send such invoices to Sage 50 in spite of having a $0 bill value.

**Late Fee Invoices**

At times, you may include a late fee or finance charge on your invoices. In such cases, you will receive a payment for the invoice amount plus that late fee amount. Earlier BillQuick transferred the invoice amount to Sage 50 but did not transfer the late fee or its payment. In order for the accounts receivable to match in the two databases (reconciliation of transactions), you had to manually create a finance charge and corresponding payment in Sage 50. The finance charge had to be for the exact amount of late fees.

However, BillQuick allows you to transfer late fee charge to Sage 50 just as standard invoices. When you create a separate late fee invoice in Invoice Review screen, BillQuick generates a manual invoice internally with an invoice number same as that of the actual invoice but with ‘LF’ appended to it. The first late fee invoice will have the same invoice number but with a prefix of LF, and any subsequent late fee invoices will have initials LF1, LF2 and so on. Once created, you can transfer this manual late fee invoice to Sage 50. You can also create a separate late fee payment for this invoice (excluding the principal amount) and then transfer it to Sage 50. While transferring late fee invoices and payments, BillQuick will post them to the appropriate Sage 50 accounts.

You can specify invoice accounts in the BillQuick-Peachtree Sync Settings screen.

**Payments**

You may decide to record payments for invoices and retainers in either BillQuick or Sage 50. Or you may choose the convenience of entering payments in BillQuick. Mark the ‘Do Not Send’ and ‘Do Not Get’ options according to your preference.
In any case, you should make use of Date Filters in the Sync Settings screen to place less burden on the BillQuick and Sage 50 databases with unnecessary data transfer.

**Best Practices**

<table>
<thead>
<tr>
<th>Items</th>
<th>BillQuick</th>
<th>Sage 50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vendors</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Activity/Service items</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Expense/Charge Items</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Clients</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Projects/Jobs</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Estimates/Budgets</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Service Fee Schedules</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Chart of Accounts</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Time</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Billing</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Vendor Bills</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Accounts Payable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Invoices</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Payments</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Payroll</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Reports</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Financial Statements</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Banking</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

*Congratulations! You have now an understanding of data integration between BillQuick and Sage 50, how to ensure that the data transfer is accurate and how to verify which records have integrated. To learn more, check our trainings.*

For more information, visit us at [www.bqe.com](http://www.bqe.com). If you have any trouble in using our integration utility, please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please call us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com.